
  PUBLIC NOTICE
FEDERAL COMMUNICATIONS COMMISSION News Media Information:  (202) 418-0500
445 12th Street, S.W. Fax-On-Demand:                (202) 418-2830
WASHINGTON DC 20554 Internet:             http://www.fcc.gov

ftp.fcc.gov
 ________________________________________________

October 1, 1999
DA 99-2062

PAHRUMP, NEVADA CLOSED BROADCAST AUCTION TO BE HELD ON
OCTOBER 6, 1999

3 Qualified Bidders

Report No. AUC-99-27-A

By this Public Notice, the Wireless Telecommunications Bureau (“WTB) and the Mass
Media Bureau (collectively, “Bureaus”), announce the auction of an FM radio construction
permit for Pahrump, Nevada, to commence October 6, 1999. This proceeding is designated as
Auction No. 27.  The spectrum to be auctioned is the subject of pending, mutually exclusive
applications for construction permits.  Pursuant to the Broadcast First Report and Order1,
participation in the auction is limited to those applicants identified in Attachment A of this Public
Notice (“Qualified Bidders”).

The Qualified Bidders previously filed acceptable “Applications to Participate in an FCC
Auction” (FCC Forms 175) (“short-form applications”) for Auction No. 25.2  Those short-form
applications are hereby accepted for purposes of participation in Auction No. 27.  The Qualified
Bidders have already furnished sufficient upfront payments.3

                    
1 See Implementation of Section 309(j) of the Communications Act – Competitive Bidding for Commercial Broadcast
and Instructional Television Fixed Service Licenses, First Report and Order  in MM Docket No. 97-234, GC Docket
No. 92-52 and GEN Docket No. 90-264, 13 FCC Rcd 15920 (1998) (“Broadcast First Report and Order”) as modified
by  Memorandum Opinion and Order, FCC 99-74, rel. April 20, 1999.

2 The short-form filing window for Auction No. 25 closed on August 20, 1999.  Minor corrective amendments were
due by no later than September 14, 1999 .  The Qualified Bidders filed and amended their short-form applications
within the applicable time frames.

3 These upfront payments were submitted for participation in Auction No. 25.  The upfront payment deadline for
Auction No. 25 was September 13, 1999.  Ramona Lee Hayes-Bell (“Bell”) submitted her upfront payment on
September 23, 1999 and attributed the delay to an error by the Nevada State Bank.  For this reason, Bell was found
not qualified to participate in Auction No. 25.  By letters dated September 23, 24 and 27, 1999, Bell sought
reconsideration of that finding or, alternatively, waiver of the Commission’s upfront payment rules.  At the direction of
the Office of the Chairman, on the afternoon of September 27, 1999, WTB orally granted Bell’s waiver request. 
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Auction No. 27 shall be conducted utilizing the minimum opening bid and upfront
payment amounts previously set for Pahrump, Nevada in Auction No. 25.4 Competitive bidding 
procedures and substantive rules adopted for Auction No. 25 shall be generally applicable for
Auction No. 27,5 however, software and network use procedures will be modified as explained
in Attachments B and C.  In addition, the proceeding is to be generally restricted under the
Commission’s ex parte rules6 and the initial schedule of competitive bidding rounds shall vary
from that employed in Auction No. 25 and is set forth below:7

Initial Bidding Schedule

The bidding schedule for Wednesday, October 6, 1999, and continuing until further notice, will
be:

Bidding Period 9:30 a.m. - 10:30 a.m. ET
Round Results 10:30 a.m. 10:45 a.m. ET

                                                                  
Consequently, the Bell application was reinstated and the Pahrump, Nevada market was removed from Auction No.
25 to allow time to reconstitute the pool of applicants to include Bell.  On September 28, 1999, Pahrump Valley
Broadcasters, Inc. filed a letter with the Commission objecting to the reinstatement and waiver and stating its
intention to file a petition for reconsideration within the period specified under Section 1.106 of the Commission’s
rules.  Applicant Milton Bozanic, through counsel, also orally objected to the reinstatement of the Bell application. 
Accordingly, if Bell prevails as winning bidder in Auction No. 27, grant of a construction permit to her would be
subject to the Commission’s ultimate disposition of any petition relating to reinstatement of her short-form
application.

4 These amounts were the subject of a notice and comment procedure prior to commencement of Auction No. 25. 
See  “Closed Broadcast Auctions Scheduled For September 28, 1999: Comments Sought on Reserve Prices or
Minimum Opening Bids and Other Auction Procedural Issues,” Public Notice, DA 99-940 (rel. May 17, 1999) and
Supplement and Erratum, DA 99-1009, rel. May 26, 1999 (collectively, “Announcement Public Notice”);  “Closed
Broadcast Auction: Notice and Filing Requirements For Auction of AM, FM, TV, LPTV and FM and TV Translator
Construction Permits Scheduled for September 28, 1999---Minimum Opening Bids and Other Procedural Issues,”
Public Notice, DA 99-1346 (re. July 9, 1999) and Erratum to Public Notice DA 99-1346, (rel. August 2, 1999),
(collectively, “Closed Broadcast Auction Public Notice”).  

5 See “Closed Broadcast Auction: 224 Qualified Bidders,” Public Notice, DA 99-1912 (rel. September 17, 1999); see
also  “Closed Broadcast Auction: Status of Applications to Participate in the Auction,” Public Notice, DA 99-1800 (rel.
September 3, 1999) and Erratum to Public Notice DA 99-1800, (rel. September 9, 1999); “New Rule Now In Effect
Concerning Equity/Debt Threshold In Use For Determining Eligibility for New Entrant Bidding Credit,” Public Notice, 
DA 99-1663 (rel. August 19, 1999); “FCC Reminds Applicants of Short Form Filing Deadline and Electronic Access
to Filing System for Auction 25 ‘Closed Broadcast Auction’” Public Notice, DA 99-1664 (rel. August 19, 1999);
“Closed Broadcast Auctions,” Public Notice, DA 99-1638 (rel. August 16, 1999); “Closed Broadcast Auctions:
Ownership Disclosure Requirements For Auctions Scheduled For September 28, 1999,” Public Notice, DA 99-1585
(rel. August 10, 1999); Closed Broadcast Public Notice; and Announcement Public Notice.

6 Spectrum auctions are usually exempt from the requirements of the ex parte rules. 47 C.F.R. 1.1200, et. seq .  See
also  “Short Form Applications Treated as Exempt for Ex Parte Purposes,” Public Notice, 9 FCC Rcd 6760 (1994). 
However, in this proceeding Bell filed a waiver request that is now opposed.  For this reason,  the proceeding is
restricted. Ex parte communications shall be generally prohibited.  In Re Amendment of 47 C.F.R. Sec. 1.1200, et.
seq. Concering Ex Parte Presentations in Commission Proceedings in GC Docket No. 95-21, Report and Order, 12
FCC Rcd 7348, at  Paras. 24-25.  However, to the extent that communications between any of the Qualified Bidders
and the Commission staff or its contractors is necessary to facilitate the submission of bids or use of the
Commission’s bidding network or software, such communication shall be permissible.  Id.

7 Further, there will be no mock auction to be conducted for Auction No. 27.
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Bidding Period 11:30 a.m. - 12:30 p.m. ET
Round Results 12:30 p.m. - 12:45 p.m. ET

Bidding Period 2:00 p.m. - 3:00 p.m. ET
Round Results 3:00 p.m. 3:15 p.m. ET

Bidding Period 4:00 p.m. - 5:00 p.m. ET
Round Results 5:00 p.m. 5:15 p.m. ET

The FCC will set the pace of the auction based upon its monitoring of the bidding and its
assessment of the auction’s progress.  Generally, the FCC will announce changes to the
bidding schedule approximately two days in advance.  Software and login codes are being
dispatched by express mail.

For further information regarding this Public Notice, please contact Kathy Garland or
Bob Reagle, Operations Branch, Auctions and Industry Analysis Division, at (717) 338-2888, or
Bob Allen, Legal Branch, Auctions and Industry Analysis Division at (202) 418-0660.  For
Technical matters, contact FCC Technical Support at (202) 414-1250.



(Sorted by Applicant)

Date of Report: 10/1/9910/1/99

The following Applicants have been found 'Qualified' to bid in Auction 27:

FCC Broadcast Auction

Qualified Bidders - Public NoticeQualified Bidders - Public Notice

27

Upfront Payment
Maximum Eligibility

FCC Account # Name
(Bid - Units)

ATTACHMENT A

Auction ID:

0271600581 Milton Bozanic $16,000.00 16,000

0271437519 Pahrump Valley Broadcasters, Inc $16,000.00 16,000

0271531291 Ramona Lee Hayes-Bell $16,000.00 16,000

Page 1 of 1Page 1 of 1



Attachment B

ACCESSING THE FCC NETWORK USING
WINDOWS 95/98

This attachment describes how to access the FCC Network from a system that is running
the Microsoft Windows 95 or Microsoft Windows 98 operating system.  This involves
configuring dial-up network access and then performing the dial-up procedure.

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer,
including buttons, Internet links, icons, tabs, menu items (e.g., Cancel
button, Auctions link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Applicant field, Selected
Licenses area of a screen).

bold italic Represents characters that you must type exactly as they appear in the
instructions.  For example, if you are instructed to type
http://wtbwww03.fcc.gov, you should type all of the characters shown in
bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information
and then press the ENTER key.

Configuring Dial-Up Networking

1. To start dial-up networking:

a. Click the Windows 95/98 Start button.
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking.

In Windows 98, click Communications, then Dial-Up Networking .

If Dial-Up Networking is not an option on your Accessories menu, you should
install it from your Windows 95/98 CD or diskettes.



2. When the Dial-Up Networking window appears, double-click the Make New
Connection icon.

The Make New Connection window appears.

3. To test your connection on the 900# that will be used during Auction 27, type
FCC Auctions 900# in the field titled Type a name for the computer you are
dialing.

Note: If you connect to the FCC’s 900# telephone service, there is a
charge of $2.30 per minute.  The first minute of connection time to the 900
number service is at no charge.

4. In Windows 95, click the down arrow at the right of the Select a modem field and
select your modem from the menu of available modems.

In Windows 98, click the down arrow at the right of the Select a device field and
select your modem from the menu of available devices.

If your modem does not appear on this list, you must install your modem driver
according to the modem manufacturer installation procedures, which are usually
described in your modem’s user manual.

5. Click the Next button.

6. To test your connection on the 900# that will be used during Auction 27, type 900
and 555-5335 in the Area Code and Telephone Number fields, respectively.

7. Verify that the correct country is selected in the Country code field.

If necessary, click the down arrow at the right of the Country code field and select
the appropriate country from the menu of available countries.

8. Click the Next button.

9. Click the Finish button.

An icon labeled FCC Auctions 900# appears in the Dial-Up Networking window.

10. Verify that properties are configured correctly before attempting a dial-up session.
Put the mouse pointer on the FCC Auctions icon that you wish to configure and
click the right mouse button to display a menu.  Click Properties from the menu.

11. Click the Configure button.  Click the Options tab at the top of the Properties
window.



12. In the Connection control area of the Options tab, verify that neither option is
selected.  If either option is selected, click the check box at the left of the option
to deselect it.  Then click OK.

13. In Windows 95, click the Server Type... button.

In Windows 98, click the Server Types tab at the top of the Properties window.

14. In the Advanced Options area, verify that only Enable software compression  is
selected.

If it is not selected, click the check box at the left of the option to select it.  If
either of the other options is selected, click the check box to deselect it.

15. In the Allowed Network Protocols area, verify that only TCP/IP is selected.

If it is not selected, click the check box at the left of the option to select it.  If
either of the other options is selected, click the check box to deselect it.

16. Click the TCP/IP Settings button and select Specify name server addresses.

17. Type 165.135.22.249 as the Primary DNS.

18. At the bottom of the TCP/IP Settings window, ensure that Use IP Header
Compression and Use Default Gateway on the Remote Network options are
selected.

19. Click OK on the TCP/IP Settings window and the Server Type window.

20. a.  Click the Windows 95/98 Start button, then click the Settings option to display
                  the Settings menu.

b.   Click Control Panel and then double-click the Network icon.

c. Highlight the TCP/IP Protocol and click Properties.  If there are multiple
      TCP/IP protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties.

d.   Click the DNS Configuration tab.

e.   Select Enable DNS. Type bidder in the Host box, type fcc.gov in the Domain
box, then type 165.135.22.249 in the DNS Server Search Order box and click
the Add button.

f. Click OK on the TCP/IP Properties windows, then click OK on the Network
      windows.



 If you are prompted to restart your computer, click Yes to restart, then begin
the Dial-Up Procedure.

Dial-Up Procedure

1. If the Dial-Up Networking window is not currently open, do the following:

a. Click the Windows 95/98 Start button.
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking

In Windows 98, click Communications, then Dial-Up Networking.

The Dial-Up Networking window appears.

2. In the Dial-Up Networking window, double-click on the FCC Auctions 900#
icon if you wish to test your connection to the 900# that will be used during
Auction 27.

Note: If you connect to the FCC’s 900 number telephone service, there is a
charge of $2.30 per minute.  The first minute of connection time to the 900
number service is at no charge.

3. Click the Connect button on the window.  Do not enter User name and
Password.

The Connection window appears, indicating the status of your connection as your
modem dials into the system.  This window must remain running during your
dial-up session.  You may minimize the window, if you wish.

If your modem fails to establish a connection, please see the Troubleshooting
section below.

4. When you have finished, click the Disconnect button on the Connection window
to end your dial-up session.

Troubleshooting

Following are problems you may encounter and possible solutions for resolving or
isolating them.

Modem does not respond

1. Confirm that all physical connections for the modem are present.



2. Confirm that the phone line is active by connecting it to a telephone and checking
for a dial-tone.

3. If you are dialing the 900 number service, check for a 900 number telephone
block.  If the volume settings are low, the modem may be dialing but not
connecting.  Check for this by dialing the 900 number on that line using a
telephone.

4. Confirm that the correct modem driver is installed for your modem.

Modem dials but does not connect

1. If you are dialing the 900 number service, check for a 900 number telephone
block.  Check for this by dialing the 900 number on that line using a telephone.

2. Confirm that the number the modem is dialing is correct.

3. Confirm that the modem prefix, if any, is correct.

Modem dials and connects, but nothing appears when you enter the Location in the
Web browser

1. Verify the Dial-Up Networking settings specified in the Configuring Dial-Up
Networking section.

2. Confirm that your Web browser is not using proxies.

Receive an Internal Server error in the Web browser

1. Confirm that the Location is correct.

2. Confirm that Java and JavaScript are enabled in your Web browser, and confirm
that Cookies is set to Accept All.

Help

For technical assistance with installing or using FCC software, contact the FCC
Technical Support Hotline at (202)-414-1250 (V) or (202)-414-1255 (TTY).  The FCC
Technical Support Hotline is generally available Monday through Friday, from 8 a.m. to
6 p.m. ET.  All calls to the FCC Technical Support Hotline are recorded.



Attachment C

FILE FORMATS

This attachment describes the formats for the round results files that will be uploaded to
the FCC Internet site and FCC Auction Bulletin Board Systems (BBS) after each round
of the auction.  There are two sets of results files.  These files are in dbf and txt format
and contain the raw output of the auction data.

The newest round results are uploaded to the Results directory based on the type of file
format: dbf and txt.

On the primary location, wtbwww01.fcc.gov:

• http://wtbwww01.fcc.gov/MMB/CP2/Auction_27/Results/dbf/
• http://wtbwww01.fcc.gov/MMB/CP2/Auction_27/Results/txt/

Note: If you cannot access these files at the preceding primary location, you can
access the same files at either of the following secondary locations:
wtbwww13.fcc.gov or www.fcc.gov/wtb/auctions/.

After every 50 rounds, files will be moved from the Results directory to archive
directories.  The following listings show an example of the directory structure for an
auction in round 102.  Note that the results for rounds 101 and 102 would be in the
Results directories.

On the primary location, wtbwww01.fcc.gov:

Rounds 1-50          http://wtbwww01.fcc.gov/MMB/CP2/Auction_27/Results/dbf/D001_050
Rounds 51-100           http://wtbwww01.fcc.gov/MMB/CP2/Auction_27/Results/dbf/D051_100
Rounds 101-102         http://wtbwww01.fcc.gov/MMB/CP2/Auction_27/Results/dbf/

Rounds 1-50        http://wtbwww01.fcc.gov/MMB/CP2/Auction_27/Results/txt/T001_050
Rounds 51-100           http://wtbwww01.fcc.gov/MMB/CP2/Auction_27/Results/txt/T051_100
Rounds 101-102         http://wtbwww01.fcc.gov/MMB/CP2/Auction_27/Results/txt/

Note:  If you cannot access the files at the preceding primary location, you can
access the same files at either of the following secondary locations:
wtbwww13.fcc.gov or www.fcc.gov/wtb/auctions/.

Round Results Files

Following are descriptions of the layouts for the dbf versions of the round results files.
The txt files will have character field types.



ALL_BIDS file
mx_group char(6)
freq_block char(2)
round_num numeric
bid_amt numeric
bidder_num numeric
fcc_acct char(10)
date date
time char(8)
net_bid_amt numeric
sort_col_1 numeric
sort_col_2 numeric
sub_market integer

HIGH_BIDS file
mx_group char(6)
freq_block char(2)
bid_round numeric
bid_amt numeric
bidder_num numeric
fcc_acct char(10)
date date
time char(8)
net_bid_amt numeric
min_accept numeric
num_of_bids numeric
sort_col_1 numeric
sort_col_2 numeric
sub_market integer

MAXIMUM_ELIGIBILITY file
round_num numeric
bidder_num numeric
fcc_acct char(10)
max_elig numeric
rmng_waivr numeric
waivr_ind char(1)
rmng_withdrawals numeric
required_act numeric
current_activity numeric

WITHDRAWALS file
mx_group char(6)
freq_block char(2)
bid_round numeric
bid_amt numeric
bidder_num numeric



fcc_acct char(10)
date date
time char(8)
net_bid_amt numeric
sort_col_1 numeric
sort_col_2 numeric
sub_market integer

BIDDER_CROSS_REFERENCE file
bidder_num numeric
fcc_acct char(10)
co_name char(50)
bidding_credit_pctg numeric


